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1. About iPad iOS 6 Development 

Essentials 

In July of 2012, Apple released financial results for the previous quarter. Included in the information provided 

was the fact that Apple has, to date, paid out over $5.5 billion to third-party developers selling applications 

on the iOS App Store. At the launch of the iPad Mini in October 2012, Apple also revealed that total sales of 

the iPad now exceed 100 million units. When the latest iPad and iPad Mini went on sale shortly after the 

launch event, Apple sold 3 million devices in the first weekend alone. 

The iPad is, by just about any measure, an enormous success. This success translates into a vast potential 

marketplace for those willing to invest the time and effort into developing compelling and high quality 

applications. The goal of this book is to make it possible for you to stake a claim in this new and rapidly 

growing market. 

1.1 The iOS 6 SDK 

When details of iOS 6 were first announced at the Apple World Wide Development Conference in June, 2012 

it seemed, on the surface at least, that the iOS 5 edition of this book would not need to be significantly 

updated for iOS 6. After gaining access to the pre-release versions of the iOS 6 SDK and working with the new 

features, however, it quickly became clear that whilst there are areas that have not changed since iOS 5, 

there is much more to the new features of iOS 6 than it had at first appeared. In actual fact, 23 new chapters 

had to be written to cover the new features of iOS 6 and every code example updated to reflect the changes 

made to Objective-C. 

How you make use of this book will depend to a large extent on whether you are new to iOS development, or 

have worked with iOS 5 and need to get up to speed on the features of iOS 6. Rest assured, however, that the 

book is intended to address both category of reader. 

1.2 For New iOS Developers 

If you are entirely new to iOS development then the entire contents of the book will be relevant to you. 

Beginning with the basics, this book provides an outline of the steps necessary to set up an iOS development 

environment. An introduction to the architecture of iOS 6 and programming in Objective-C is provided, 

followed by an in-depth look at the design of iPad applications and user interfaces. More advanced topics 

such as file handling, database management, in-app purchases, graphics drawing and animation are also 

covered, as are touch screen handling, gesture recognition, multitasking, iAds integration, location 

management, local notifications, camera access and video and audio playback support. New iOS 6 specific 
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features are also covered including Auto Layout, Twitter and Facebook integration, event reminders, App 

Store hosted in-app purchase content, collection views and much more. 

The aim of this book, therefore, is to teach you the skills necessary to build your own apps for the iPad. 

Assuming you are ready to download the iOS 6 SDK and Xcode, have an Intel-based Mac and some ideas for 

some apps to develop, you are ready to get started. 

1.3 For iOS 5 Developers 

If you have already read iPad iOS 5 Development Essentials, or have experience with the iOS 5 SDK then you 

might prefer to go directly to the new chapters in this iOS 6 edition of the book. As previously mentioned, if 

you have already read iPad iOS 5 Development Essentials, you will find no fewer than 23 new chapters in this 

latest edition. 

Chapters included in this edition that were not contained in the previous edition are as follows: 

 The Basics of Modern Objective-C 

 An Introduction to Auto Layout in iOS 6 

 Working with iOS 6 Auto Layout Constraints in Interface Builder 

 An iPad iOS 6 Auto Layout Example 

 Implementing iOS 6 Auto Layout Constraints in Code 

 Implementing Cross-Hierarchy Auto Layout Constraints in iOS 6 

 Understanding the iOS 6 Auto Layout Visual Format Language 

 An Overview of iOS 6 Collection View and Flow Layout 

 An iPad iOS 6 Storyboard-based Collection View Tutorial 

 Subclassing and Extending the iOS 6 Collection View Flow Layout 

 An Overview of iOS 6 Application State Preservation and Restoration 

 An iOS 6 iPad State Preservation and Restoration Tutorial 

 Integrating Maps into iPad iOS 6 Applications using MKMapItem 

 An Example iOS 6 iPad MKMapItem Application 

 Using iOS 6 Event Kit to Create Date and Location Based Reminders 

 Integrating Twitter and Facebook into iPad iOS 6 Applications 

 An iPad iOS 6 Facebook Integration Tutorial using UIActivityViewController 

 iPad iOS 6 Facebook and Twitter Integration using SLRequest 

 Making Store Purchases with the SKStoreProductViewController Class 

 Building In-App Purchasing into iPad iOS 6 Applications 

 Preparing an iOS 6 Application for In-App Purchases 

 An iPad iOS 6 In-App Purchase Tutorial 

 Configuring and Creating App Store Hosted Content for iOS 6 In-App Purchases 

In addition, the chapter entitled Using Xcode Storyboarding with iOS 6 has been updated to include coverage 

of the new segue unwinding feature of iOS 6 and An Overview of iPad iOS 6 Table Views and Xcode 

Storyboards  has been modified to introduce the new iOS 6 model for reusing Table View cells. 
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Finally, all the code examples have been updated to reflect the changes to Objective-C including the removal 

of the viewDidUnload: method, literal syntax for number, array and dictionaries and default property 

synthesis. 

1.4 Source Code Download 

The source code and Xcode project files for the examples contained in this book are available for download at 

http://www.ebookfrenzy.com/code/ipadios6.zip. 

1.5 Feedback 

We want you to be satisfied with your purchase of this book. If you find any errors in the book, or have any 

comments, questions or concerns please contact us at feedback@ebookfrenzy.com. 

1.6 Errata 

Whilst we make every effort to ensure the accuracy of the content of this book, it is inevitable that a book 

covering a subject area of this size and complexity may include some errors and oversights. Any known issues 

with the book will be outlined, together with solutions at the following URL: 

http://www.ebookfrenzy.com/errata/ipad_ios6.html 

In the event that you find an error not listed in the errata, please let us know by emailing our technical 

support team at feedback@ebookfrenzy.com. 

http://www.ebookfrenzy.com/code/ipadios6.zip
mailto:feedback@ebookfrenzy.com
http://www.ebookfrenzy.com/errata/ipad_ios6.html
mailto:feedback@ebookfrenzy.com
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2. The History of iOS 

When Objective-C 2.0 Essentials (a companion book to iPad iOS 6 Development Essentials) was published in 

2010 one of the most popular chapters was, rather surprisingly, one entitled “The History of Objective-C”. 

Since much of the history of Objective-C also applies to iOS it seemed to make sense to  adapt the original 

Objective-C chapter to also tell the history of iOS. 

In the 1970s Steve Jobs and Steve Wozniak founded Apple Computer. After many years of success, Steve Jobs 

hired a marketing wizard from PepsiCo named John Sculley to help take Apple to the next level of business 

success. To cut a long story short, a boardroom battle ensued and Steve Jobs got pushed out of the company 

(for the long version of the story pick up a used copy of John Sculley's book Odyssey: From Pepsi to Apple) 

leaving John Sculley in charge.  

After leaving Apple Jobs started a new company, which he named NeXT, to design an entirely new generation 

of computer systems. The operating system developed by NeXT to run on these computers was called 

NeXTStep and was based on the Mach kernel developed at Carnegie Mellon University and the Berkeley 

Standard Distribution (BSD) system developed at the University of California, Berkeley which, in turn, was 

based on the UNIX operating system. As it became clear that the NeXT hardware was a commercial failure, 

NeXT subsequently joined forces with Sun Microsystems to create a standardized version of NeXTStep named 

OPENstep which the Free Software Foundation then adopted as GNUstep.  

During the 1990s, John Sculley left Apple and a procession of new CEOs came and went. During this time, 

Apple had been losing market share and struggling to come out with a new operating system to replace the 

aging Mac OS. After a number of failed attempts and partnerships, it was eventually decided that rather than 

try to write a new operating system, Apple should acquire a company that already had one. During Gil 

Amelio's brief reign as CEO, a shortlist of two companies was drawn up. One was a company called Be, Inc. 

founded by a former Apple employee named Jean-Louis Gassée, and the other was NeXT.  

Ultimately, NeXT was selected and Steve Jobs once again joined Apple. In another boardroom struggle 

(another long story as outlined in Gil Amelio's book On the Firing Line: My 500 Days at Apple) Steve Jobs 

pushed out Gil Amelio and once again became CEO of the company he had founded all those years ago.  

The rest, as they say, is history. NeXTStep formed much of the foundation for the operating system that 

became Mac OS X. Mac OS X was subsequently modified to provide the operating system for the 

spectacularly successful iPhone. What was then called iPhone OS was later renamed iOS to coincide with the 

introduction of the iPad. 

Although there is little obvious evidence of the history of iOS in the SDK there is one constant reminder for 

those aware of the operating system’s origins. Whilst working through this book you will encounter a number 

Chapter 2 



The History of iOS 

6 

of Foundation Framework class names that begin the letters “NS” such as NSArray and NSString. The letters 

“NS” refer, of course, to the ‘N’ and ‘S’ in NeXTStep. 
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3. Joining the Apple iOS Developer 

Program 

The first step in the process of learning to develop iOS 6 based iPad applications involves gaining an 

understanding of the differences between Registered Apple Developers and iOS Developer Program 

Members. Having gained such an understanding, the next choice is to decide the point at which it makes 

sense for you to pay to join the iOS Developer Program. With these goals in mind, this chapter will cover the 

differences between the two categories of developer, outline the costs and benefits of joining the developer 

program and, finally, walk through the steps involved in obtaining each membership level.  

3.1 Registered Apple Developer 

There is no fee associated with becoming a registered Apple developer. Simply visit the following web page 
to begin the registration process: 

http://developer.apple.com/programs/register/ 

An existing Apple ID (used for making iTunes or Apple Store purchases) is usually adequate to complete the 
registration process.  

Once the registration process is complete, access is provided to developer resources such as online 
documentation and tutorials. Registered developers are also able to download older versions of the iOS SDK 
and Xcode development environment.  

3.2 Downloading Xcode and the iOS 6 SDK 

The latest versions of both the iOS SDK and Xcode can be downloaded free of charge from the Mac App 
Store. Since the tools are free, this raises the question of whether to upgrade to the iOS Developer Program, 
or to remain as a Registered Apple Developer. It is important, therefore, to understand the key benefits of 
the iOS Developer Program. 

3.3 iOS Developer Program 

Membership in the iOS Developer Program currently costs $99 per year. As previously mentioned, 
membership includes access to the latest versions of the iOS SDK and Xcode development environment. The 
benefits of membership, however, go far beyond those offered at the Registered Apple Developer level. 

One of the key advantages of the developer program is that it permits the creation of certificates and 
provisioning profiles to test applications on physical devices. Although Xcode includes device simulators 
which allow for a significant amount of testing to be performed, there are certain areas of functionality, such 
as location tracking and device motion, which can only fully be tested on a physical device. Of particular 

Chapter 3 

http://developer.apple.com/programs/register/


Joining the Apple iOS Developer Program 

8 

significance is the fact that iCloud access, Reminders and In-App Purchasing can only be tested when 
applications are running on physical devices. 

Of further significance is the fact that iOS Developer Program members have unrestricted access to the full 
range of guides and tutorials relating to the latest iOS SDK and, more importantly, have access to technical 
support from Apple’s iOS technical support engineers (though the annual fee covers the submission of only 
two support incident reports). 

By far the most important aspect of the iOS Developer Program is that membership is a mandatory 
requirement in order to publish an application for sale or download in the App Store. 

Clearly, developer program membership is going to be required at some point before your application 
reaches the App Store. The only question remaining is when exactly to sign up. 

3.4 When to Enroll in the iOS Developer Program? 

Clearly, there are many benefits to iOS Developer Program membership and, eventually, membership will be 

necessary to begin selling applications. As to whether or not to pay the enrollment fee now or later will 

depend on individual circumstances. If you are still in the early stages of learning to develop iOS applications 

or have yet to come up with a compelling idea for an application to develop then much of what you need is 

provided in the Registered Apple Developer package. As your skill level increases and your ideas for 

applications to develop take shape you can, after all, always enroll in the developer program at a later date. 

If, on the other hand, you are confident that you will reach the stage of having an application ready to publish 

or know that you will need to test the functionality of the application on a physical device as opposed to a 

simulator then it is worth joining the developer program sooner rather than later. 

3.5 Enrolling in the iOS Developer Program 

If your goal is to develop iPad applications for your employer then it is first worth checking whether the 
company already has membership. That being the case, contact the program administrator in your company 
and ask them to send you an invitation from within the iOS Developer Program Member Center to join the 
team. Once they have done so, Apple will send you an email entitled You Have Been Invited to Join an Apple 
Developer Program containing a link to activate your membership. If you or your company is not already a 
program member, you can enroll online at: 

http://developer.apple.com/programs/ios/  

Apple provides enrollment options for businesses and individuals. To enroll as an individual you will need to 
provide credit card information in order to verify your identity. To enroll as a company you must have legal 
signature authority (or access to someone who does) and be able to provide documentation such as Articles 
of Incorporation and a Business License.  

Acceptance into the developer program as an individual member typically takes less than 24 hours with 
notification arriving in the form of an activation email from Apple. Enrollment as a company can take 
considerably longer (sometimes weeks or even months) due to the burden of the additional verification 
requirements. 

Whilst awaiting activation you may log into the Member Center with restricted access using your Apple ID 
and password at the following URL: 

http://developer.apple.com/programs/ios/
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 http://developer.apple.com/membercenter 

Once logged in, clicking on the Your Account tab at the top of the page will display the prevailing status of 
your application to join the developer program as Enrollment Pending: 

 

Figure 3-1 

Once the activation email has arrived, log into the Member Center again and note that access is now 
available to a wide range of options and resources as illustrated in Figure 3-2: 

 

Figure 3-2 

3.6 Summary 

An important early step in iPad iOS 6 application development process involves registering as an Apple 
Developer and identifying the best time to upgrade to iOS Developer Program membership. This chapter has 
outlined the differences between the two programs, provided some guidance to keep in mind when 
considering developer program membership and walked briefly through the enrollment process. The next 
step is to download and install the iOS 6 SDK and Xcode development environment. 

http://developer.apple.com/membercenter
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4. Installing Xcode 4 and the iOS 6 SDK 

iPad apps are developed using the iOS SDK in conjunction with Apple’s Xcode 4.x development environment. 
The iOS SDK contains the development frameworks that will be outlined in iOS 6 Architecture and SDK 
Frameworks. Xcode 4.x is an integrated development environment (IDE) within which you will code, compile, 
test and debug your iOS iPad applications. The Xcode environment also includes a feature called Interface 
Builder which enables you to graphically design the user interface of your application using the components 
provided by the UIKit framework.  

In this chapter we will cover the steps involved in installing both Xcode and the iOS 6 SDK on Mac OS X.  

4.1 Identifying if you have an Intel or PowerPC based Mac 

Only Intel based Mac OS X systems can be used to develop applications for iOS. If you have an older, PowerPC 

based Mac then you will need to purchase a new system before you can begin your iPad app development 

project. If you are unsure of the processor type inside your Mac, you can find this information by clicking on 

the Apple menu in the top left hand corner of the screen and selecting the About This Mac option from the 

menu. In the resulting dialog check the Processor line. Figure 4-1 illustrates the results obtained on an Intel 

based system. 

 

Figure 4-1 

If the dialog on your Mac does not reflect the presence of an Intel based processor then your current system 

is, sadly, unsuitable as a platform for iPad iOS app development.  

In addition, the iOS 6 SDK with Xcode 4.5 environment requires that the version of Mac OS X running on the 

system be version 10.7.4 or later. If the “About This Mac” dialog does not indicate that Mac OS X 10.7.4 or 
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later is running, click on the Software Update… button to download and install the appropriate operating 

system upgrades. 

4.2 Installing Xcode and the iOS 6 SDK 

The best way to obtain the latest versions of Xcode and the iOS SDK is to download them from the Apple iOS 

Dev Center web site at: 

https://developer.apple.com/xcode 

The download is over 1.6GB in size and may take a number of hours to complete depending on the speed of 

your internet connection.  

4.3 Starting Xcode 

Having successfully installed the SDK and Xcode , the next step is to launch it so that we can write and then 

create a sample iPad application. To start up Xcode, open the Finder and search for Xcode. Since you will be 

making frequent use of this tool take this opportunity to drag and drop it into your dock for easier access in 

the future. Click on the Xcode icon in the dock to launch the tool.  

Once Xcode has loaded, and assuming this is the first time you have used Xcode on this system, you will be 

presented with the Welcome screen from which you are ready to proceed: 

 

Figure 4-2 

Having installed the iOS 6 SDK and successfully launched Xcode we can now look at Creating a Simple iPad 

iOS 6 App. 

4.4 Summary 

Before iPad application development work can begin the first step is to install the iOS 6 SDK and Xcode 

development environment onto an Intel based Mac OS X system. In this chapter we have explored the steps 

involved in achieving this. 
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5. Creating a Simple iPad iOS 6 App 

It is traditional in books covering programming topics to provide a very simple example early on. This 

practice, though still common, has been maligned by some authors of recent books. Those authors, however, 

are missing the point of the simple example. One key purpose of such an exercise is to provide a very simple 

way to verify that your development environment is correctly installed and fully operational before moving 

on to more complex tasks. A secondary objective is to give the reader a quick success very early in the 

learning curve to inspire an initial level of confidence. There is very little to be gained by plunging into 

complex examples that confuse the reader before having taken time to explain the underlying concepts of 

the technology. 

With this in mind, iPad iOS 6 Development Essentials will remain true to tradition and provide a very simple 

example with which to get started. In doing so, we will also be honoring another time honored tradition by 

providing this example in the form of a simple “Hello World” program. The “Hello World” example was first 

used in a book called the C Programming Language written by the creators of C, Brian Kernighan and Dennis 

Richie. Given that the origins of Objective-C can be traced back to the C programming language it is only 

fitting that we use this example for iOS 6 and the iPad. 

5.1 Starting Xcode 

As with all iOS examples in this book, the development of our example will take place within the Xcode 4 

development environment. If you have not already installed this tool together with the latest iOS SDK refer 

first to the Installing Xcode 4 and the iOS 6 SDK chapter of this book. Assuming that the installation is 

complete, launch Xcode either by clicking on the icon on the dock (assuming you created one) or use the 

Finder tool to search for Xcode. 

When launched for the first time, and until you turn off the Show this window when Xcode launches toggle, 

the screen illustrated in Figure 5-1 will appear by default: 
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Figure 5-1 

If you do not see this window, simply select the Window -> Welcome to Xcode menu option to display it. 

From within this window click on the option to Create a new Xcode project. This will display the main Xcode 4 

project window together with the New Project panel where we are able to select a template matching the 

type of project we want to develop: 

 

Figure 5-2 

The panel located on the left hand side of the window allows for the selection of the target platform 

providing options to develop an application either for an iOS based device or Mac OS X. 

Begin by making sure that the Application option located beneath iOS is selected. The main panel contains a 

list of templates available to use as the basis for an application. The options available are as follows: 
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 Master-Detail Application – Used to create a list based application. Selecting an item from a master list 

displays a detail view corresponding to the selection. The template then provides a Back button to return 

to the list. You may have seen a similar technique used for news based applications, whereby selecting 

an item from a list of headlines displays the content of the corresponding news article. When used for an 

iPad based application this template implements a basic split-view configuration. 

 OpenGL Game – The OpenGL ES framework provides an API for developing advanced graphics drawing 

and animation capabilities. The OpenGL ES Game template creates a basic application containing an 

OpenGL ES view upon which to draw and manipulate graphics and a timer object. 

 Page-based Application – Creates a template project using the page view controller designed to allow 

views to be transitioned by turning pages on the screen. 

 Tabbed Application – Creates a template application with a tab bar. The tab bar typically appears across 

the bottom of the device display and can be programmed to contain items that, when selected, change 

the main display to different views. The iPhone’s built-in Phone user interface, for example, uses a tab 

bar to allow the user to move between favorites, contacts, keypad and voicemail. 

 Utility Application – Creates a template consisting of a two sided view. For an example of a utility 

application in action, load up the standard iPhone weather application. Pressing the blue info button flips 

the view to the configuration page. Selecting Done rotates the view back to the main screen. 

 Single View Application – Creates a basic template for an application containing a single view and 

corresponding view controller. 

 Empty Application – The most basic of templates this creates only a window and a delegate. If none of 

the above templates match your requirements then this is the option to take. 

For the purposes of our simple example, we are going to use the Single View Application template so select 

this option from the new project window and click Next to configure some project options: 

 

Figure 5-3 

On this screen, enter a Product name for the application that is going to be created, in this case “HelloWorld” 

and make sure that the class prefix matches this name. The company identifier is typically the reversed URL 
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of your company’s website, for example “com.mycompany”. This will be used when creating provisioning 

profiles and certificates to enable applications to be tested on a physical iPad device (covered in more detail 

in Testing iOS 6 Apps on the iPad – Developer Certificates and Provisioning Profiles). Enter the Class Prefix 

value of “HelloWorld” which will be used to prefix any classes created for us by Xcode when the template 

project is created. 

Make sure that iPad is currently selected from the Devices menu and that neither the Use Storyboard nor the 

Include Unit Tests options are currently selected.  

Automatic Reference Counting is a feature included with the Objective-C compiler which removes much of 

the responsibility from the developer for releasing objects when they are no longer needed. This is an 

extremely useful new feature and, as such, the option should be selected before clicking the Next button to 

proceed. On the final screen, choose a location on the file system for the new project to be created and click 

on Create. 

Once the new project has been created the main Xcode window will appear as illustrated in Figure 5-4: 

 

Figure 5-4 

Before proceeding we should take some time to look at what Xcode has done for us. Firstly it has created a 
group of files that we will need to create our application. Some of these are Objective-C source code files 
(with a .m extension) where we will enter the code to make our application work, others are header or 
interface files (.h) that are included by the source files and are where we will also need to put our own 
declarations and definitions. In addition, the .xib file is the save file used by the Interface Builder tool to hold 
the user interface design we will create. Older versions of Interface Builder saved designs in files with a .nib 
extension so these files, even today, are called NIB files. Also present will be one or more files with a .plist file 
extension. These are Property List files which contain key/value pair information. For example, the 
HelloWorld-info.plist file contains resource settings relating to items such as the language, icon file, 
executable name and app identifier. The list of files is displayed in the Project Navigator located in the left 
hand panel of the main Xcode project window. A toolbar at the top of this panel contains build and run 
status, breakpoints, scheme selections and a range of settings to configure the panels displayed by Xcode. 
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By default, the center panel of the window shows a summary of the settings for the application. This includes 
the identifier specified during the project creation process and the target device. Options are also provided to 
configure the orientations of the device that are to be supported by the application together with options to 
upload an icon (the small image the user selects on the device screen to launch the application) and splash 
screen image (displayed to the user while the application loads) for the application. 

In addition to the Summary screen, tabs are provided to view and modify additional settings consisting of 
Info, Build Settings, Build Phases and Build Rules. As we progress through subsequent chapters of this book 
we will explore some of these other configuration options in greater detail. To return to the Summary panel 
at any future point in time, make sure the Project Navigator is selected in the left hand panel and select the 
top item (the application name) in the navigator list. 

When a source file is selected from the list in the navigator panel, the contents of that file will appear in the 
center panel where it may then be edited. To open the file in a separate editing window, simply double click 
on the file in the list. 

5.2 Creating the iOS App User Interface 

Simply by the very nature of the environment in which they run, iPad apps are typically visually oriented. As 
such, a key component of just about any app involves a user interface through which the user will interact 
with the application and, in turn, receive feedback. Whilst it is possible to develop user interfaces by writing 
code to create and position items on the screen, this is a complex and error prone process. In recognition of 
this, Apple provides a tool called Interface Builder which allows a user interface to be visually constructed by 
dragging and dropping components onto a canvas and setting properties to configure the appearance and 
behavior of those components. Interface Builder was originally developed some time ago for creating Mac OS 
X applications, but has now been updated to allow for the design of iOS app user interfaces.  

As mentioned in the preceding section, Xcode pre-created a number of files for our project, one of which has 
a .xib filename extension. This is an Interface Builder save file (remember that they are called NIB files, not 
XIB files). The file we are interested in for our HelloWorld project is called HelloWorldViewController.xib. To 
load this file into Interface Builder simply select the file name in the list in the left hand panel. Interface 
Builder will subsequently appear in the center panel as shown in Figure 5-5: 

 

Figure 5-5 
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In the center panel a visual representation of the user interface of the application is displayed. Initially this 
consists solely of the UIView object. This UIView object was added to our design by Xcode when we selected 
the Single View Application option during the project creation phase. We will construct the user interface for 
our HelloWorld app by dragging and dropping user interface objects onto this UIView object.  Designing a 
user interface consists primarily of dragging and dropping visual components onto the canvas and setting a 
range of properties and settings. In order to access objects and property settings it is necessary to display the 
Xcode right hand panel. This is achieved by selecting the right hand button in the View section of the Xcode 
toolbar: 

 

Figure 5-6 

The right hand panel, once displayed, will appear as illustrated in Figure 5-7: 

 

Figure 5-7 

Along the top edge of the panel is a row of buttons which change the settings displayed in the upper half of 
the panel. By default the File Inspector is displayed. Options are also provided to display quick help, the 
Identity Inspector, Attributes Inspector, Size Inspector and Connections Inspector. Before proceeding, take 
some time to review each of these selections to gain some familiarity with the configuration options each 
provides. Throughout the remainder of this book extensive use of these inspectors will be made. 
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The lower section of the panel defaults to displaying the file template library. Above this panel is another 
toolbar containing buttons to display other categories. Options include frequently used code snippets to save 
on typing when writing code, the object library and the media library. For the purposes of this tutorial we 
need to display the object library so click in the appropriate toolbar button (the three dimensional cube). This 
will display the UI components that can be used to construct our user interface. Move the cursor to the line 
above the lower toolbar and click and drag to increase the amount of space available for the library if 
required. In addition, the objects are categorized into groups which may be selected using the menu beneath 
the toolbar. The layout buttons may also be used to switch from a single column of objects with descriptions 
to multiple columns without descriptions. 

5.3 Changing Component Properties 

With the property panel for the View selected in the main panel, we will begin our design work by changing 
the background color of this view. Begin by making sure the View is selected and that the Attribute Inspector 
(View -> Utilities -> Show Attribute Inspector) is displayed in the right hand panel. Click on the gray rectangle 
next to the Background label to invoke the Colors dialog. Using the color selection tool, choose a visually 
pleasing color and close the dialog. You will now notice that the view window has changed from gray to the 
new color selection. 

5.4 Adding Objects to the User Interface 

The next step is to add a Label object to our view. To achieve this, select Cocoa Touch -> Controls from the 
library panel menu, click on the Label object and drag it to the center of the view. Once it is in position 
release the mouse button to drop it at that location: 

 

Figure 5-8 

Using the blue markers surrounding the label border, stretch first the left and then right side of the label out 
to the edge of the view until the vertical blue dotted lines marking the recommended border of the view 
appear. With the Label still selected, click on the centered alignment button in the Layout attribute section of 
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the Attribute Inspector (View -> Utilities -> Show Attribute Inspector) to center the text in the middle of the 
screen. Click on the current font attribute setting to choose a larger font setting, for example a Georgia bold 
typeface with a size of 24. 

Finally, double click on the text in the label that currently reads “Label” and type in “Hello World”. At this 
point, your View window will hopefully appear as outlined in Figure 5-9 (allowing, of course, for differences in 
your color and font choices): 

 

Figure 5-9 

Having created our simple user interface design we now need to save it. To achieve this, select File -> Save or 
use the Command+S keyboard shortcut.  

5.5 Building and Running an iOS App in Xcode 

Before an app can be run it must first be compiled. Once successfully compiled it may be run either within a 
simulator or on a physical iPhone, iPad or iPod Touch device. The process for testing an app on a physical 
device requires some additional steps to be performed involving developer certificates and provisioning 
profiles and will be covered in detail in Testing iOS 6 Apps on the iPad – Developer Certificates and 
Provisioning Profiles. For the purposes of this chapter, however, it is sufficient to run the app in the simulator. 

Within the main Xcode 4 project window make sure that the menu located in the top left hand corner of the 
window (to the right of the Stop button) has the iPad 6.0 Simulator option selected and then click on the Run 
toolbar button to compile the code and run the app in the simulator. The small iTunes style window in the 
center of the Xcode toolbar will report the progress of the build process together with any problems or errors 
that cause the build process to fail. Once the app is built, the simulator will start and the HelloWorld app will 
run: 
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Figure 5-10 

5.6 Dealing with Build Errors 

As we have not actually written or modified any code in this chapter it is unlikely that any errors will be 

detected during the build and run process. In the unlikely event that something did get inadvertently 

changed thereby causing the build to fail it is worth taking a few minutes to talk about build errors within the 

context of the Xcode environment. 

If for any reason a build fails, the status window in the Xcode 4 toolbar will report that an error has been 
detected by displaying “Build” together with the number of errors detected and any warnings. In addition, 
the left hand panel of the Xcode window will update with a list of the errors. Selecting an error from this list 
will take you to the location in the code where corrective action needs to be taken. 

5.7 Testing Different Screen Sizes 

iPad applications need to be able to work on two different screen resolutions.  The displays of the iPad Mini 
and iPad 2 both have a resolution of 1024 x 768. The retina screen of more recent full size iPads, on the other 
hand, have a resolution of 2048 x 1536.  

In order to test the appearance of an application on these different displays, simply launch the application in 
the iOS Simulator and switch between the two different display resolutions using the Hardware -> Device 
menu options. 

5.8 Summary 

A simple example is a good way to verify that the development environment is correctly installed and 

operational. It also provides an early level of confidence that a more complex example would fail to provide. 
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In this chapter we have created a very simple iPad iOS 6 application consisting of a colored background a 

label object. 
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6. iOS 6 Architecture and SDK 

Frameworks 

When we develop apps for the iPad, Apple does not allow us direct access to any of the device hardware. In 

fact, all hardware interaction takes place exclusively through a number of different layers of software which 

act as intermediaries between the application code and device hardware. These layers make up what is 

known as an operating system. In the case of the iPad, this operating system is known as iOS.  

In order to gain a better understanding of the iPad development environment, this chapter will look in detail 

at the different layers that comprise the iOS operating system and the frameworks that allow us, as 

developers, to write iPad applications. 

6.1 iPhone OS becomes iOS 

Prior to the release of the iPad in 2010, the operating system running on the iPhone was generally referred to 

as iPhone OS. Given that the operating system used for the iPad is essentially the same as that on the iPhone 

it didn’t make much sense to name it iPad OS. Instead, Apple decided to adopt a more generic and non-

device specific name for the operating system. Given Apple’s predilection for names prefixed with the letter 

‘i’ (iTunes, iBookstore, iMac etc) the logical choice was, of course, iOS. Unfortunately, iOS is also the name 

used by Cisco for the operating system on its routers (Apple, it seems, also has a predilection for ignoring 

trademarks). When performing an internet search for iOS, therefore, be prepared to see large numbers of 

results for Cisco’s iOS which have absolutely nothing to do with Apple’s iOS.  

6.2 An Overview of the iOS 6 Architecture 

As previously mentioned, iOS consists of a number of different software layers, each of which provides 

programming frameworks for the development of applications that run on top of the underlying hardware. 

These operating system layers can be presented diagrammatically as illustrated in Figure 6-1: 

Chapter 6 
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Figure 6-1 

Some diagrams designed to graphically depict the iOS software stack show an additional box positioned 

above the Cocoa Touch layer to indicate the applications running on the device. In the above diagram we 

have not done so since this would suggest that the only interface available to the app is Cocoa Touch. In 

practice, an app can directly call down any of the layers of the stack to perform tasks on the physical device.  

That said, however, each operating system layer provides an increasing level of abstraction away from the 

complexity of working with the hardware. As an iOS developer you should, therefore, always look for 

solutions to your programming goals in the frameworks located in the higher level iOS layers before resorting 

to writing code that reaches down to the lower level layers. In general, the higher level of layer you program 

to, the less effort and fewer lines of code you will have to write to achieve your objective. And as any veteran 

programmer will tell you, the less code you have to write the less opportunity you have to introduce bugs. 

Now that we have identified the various layers that comprise iOS 6 we can now look in more detail at the 

services provided by each layer and the corresponding frameworks that make those services available to us 

as application developers. 

6.3 The Cocoa Touch Layer 

The Cocoa Touch layer sits at the top of the iOS stack and contains the frameworks that are most commonly 

used by iPad application developers. Cocoa Touch is primarily written in Objective-C, is based on the standard 

Mac OS X Cocoa API (as found on Apple desktop and laptop computers) and has been extended and modified 

to meet the needs of the iPad hardware. 

The Cocoa Touch layer provides the following frameworks for iPad app development: 

6.3.1 UIKit Framework (UIKit.framework) 

The UIKit framework is a vast and feature rich Objective-C based programming interface. It is, without 

question, the framework with which you will spend most of your time working. Entire books could, and 

probably will, be written about the UIKit framework alone. Some of the key features of UIKit are as follows: 

 User interface creation and management (text fields, buttons, labels, colors, fonts etc) 
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 Application lifecycle management 

 Application event handling (e.g. touch screen user interaction) 

 Multitasking 

 Wireless Printing 

 Data protection via encryption 

 Cut, copy, and paste functionality 

 Web and text content presentation and management 

 Data handling 

 Inter-application integration 

 Push notification in conjunction with Push Notification Service 

 Local notifications (a mechanism whereby an application running in the background can gain the user’s 

attention) 

 Accessibility 

 Accelerometer, battery, proximity sensor, camera and photo library interaction 

 Touch screen gesture recognition 

 File sharing (the ability to make application files stored on the device available via iTunes) 

 Blue tooth based peer to peer connectivity between devices 

 Connection to external displays 

To get a feel for the richness of this framework it is worth spending some time browsing Apple’s UIKit 

reference material which is available online at: 

http://developer.apple.com/library/ios/#documentation/UIKit/Reference/UIKit_Framework/index.html 

6.3.2 Map Kit Framework (MapKit.framework) 

If you have spent any appreciable time with an iPhone or iPad then the chances are you have needed to use 

the Maps application more than once, either to get a map of a specific area or to generate driving directions 

to get you to your intended destination. The Map Kit framework provides a programming interface which 

enables you to build map based capabilities into your own applications. This allows you to, amongst other 

things, display scrollable maps for any location, display the map corresponding to the current geographical 

location of the device and annotate the map in a variety of ways. 

6.3.3 Push Notification Service 

The Push Notification Service allows applications to notify users of an event even when the application is not 

currently running on the device. Since the introduction of this service it has most commonly been used by 

news based applications. Typically when there is breaking news the service will generate a message on the 

device with the news headline and provide the user the option to load the corresponding news app to read 

http://developer.apple.com/library/ios/#documentation/UIKit/Reference/UIKit_Framework/index.html
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more details. This alert is typically accompanied by an audio alert and vibration of the device. This feature 

should be used sparingly to avoid annoying the user with frequent interruptions.  

6.3.4 Message UI Framework (MessageUI.framework) 

The Message UI framework provides everything you need to allow users to compose and send email 

messages from within your application. In fact, the framework even provides the user interface elements 

through which the user enters the email addressing information and message content. Alternatively, this 

information may be pre-defined within your application and then displayed for the user to edit and approve 

prior to sending. 

6.3.5 Address Book UI Framework (AddressUI.framework) 

Given that a key function of the iPad is as a communications device and digital assistant it should not come as 

too much of a surprise that an entire framework is dedicated to the integration of the address book data into 

your own applications. The primary purpose of the framework is to enable you to access, display, edit and 

enter contact information from the iPad address book from within your own application. 

6.3.6 Game Kit Framework (GameKit.framework) 

The Game Kit framework provides peer-to-peer connectivity and voice communication between multiple 

devices and users allowing those running the same app to interact. When this feature was first introduced it 

was anticipated by Apple that it would primarily be used in multi-player games (hence the choice of name) 

but the possible applications for this feature clearly extend far beyond games development. 

6.3.7 iAd Framework (iAd.framework) 

The purpose of the iAd Framework is to allow developers to include banner advertising within their 

applications. All advertisements are served by Apple’s own ad service.  

6.3.8 Event Kit UI Framework (EventKit.framework) 

The Event Kit UI framework was introduced in iOS 4 and is provided to allow the calendar and reminder 

events to be accessed and edited from within an application. 

6.3.9 Accounts Framework (Accounts.framework) 

iOS 5 introduced the concept of system accounts. These essentially allow the account information for other 

services to be stored on the iOS device and accessed from within application code. Currently system accounts 

are limited to Twitter accounts, though other services such as Facebook will likely appear in future iOS 

releases. The purpose of the Accounts Framework is to provide an API allowing applications to access and 

manage these system accounts. 

6.3.10 Social Framework (Social.framework) 

The Social Framework allows Twitter, Facebook and Sina Weibo integration to be added to applications. The 

framework operates in conjunction the Accounts Framework to gain access to the user’s social network 

account information. 
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6.4 The iOS Media Layer 

The role of the Media layer is to provide iOS with audio, video, animation and graphics capabilities. As with 

the other layers comprising the iOS stack, the Media layer comprises a number of frameworks which may be 

utilized when developing iPad apps. In this section we will look at each one in turn. 

6.4.1 Core Video Framework (CoreVideo.framework) 

The Core Video Framework provides buffering support for the Core Media framework. Whilst this may be 

utilized by application developers it is typically not necessary to use this framework. 

6.4.2 Core Text Framework (CoreText.framework) 

The iOS Core Text framework is a C-based API designed to ease the handling of advanced text layout and font 

rendering requirements.  

6.4.3 Image I/O Framework (ImageIO.framework) 

The Image I/O framework, the purpose of which is to facilitate the importing and exporting of image data and 

image metadata, was introduced in iOS 4. The framework supports a wide range of image formats including 

PNG, JPEG, TIFF and GIF. 

6.4.4 Assets Library Framework (AssetsLibrary.framework) 

The Assets Library provides a mechanism for locating and retrieving video and photo files located on the iPad 

device. In addition to accessing existing images and videos, this framework also allows new photos and 

videos to be saved to the standard device photo album. 

6.4.5 Core Graphics Framework (CoreGraphics.framework) 

The iOS Core Graphics Framework (otherwise known as the Quartz 2D API) provides a lightweight two 

dimensional rendering engine. Features of this framework include PDF document creation and presentation, 

vector based drawing, transparent layers, path based drawing, anti-aliased rendering, color manipulation and 

management, image rendering and gradients. Those familiar with the Quartz 2D API running on MacOS X will 

be pleased to learn that the implementation of this API is the same on iOS. 

6.4.6 Core Image Framework (CoreImage.framework) 

A framework introduced with iOS 5 providing a set of video and image filtering and manipulation capabilities 

for application developers.  

6.4.7 Quartz Core Framework (QuartzCore.framework) 

The purpose of the Quartz Core framework is to provide animation capabilities on the iPad. It provides the 

foundation for the majority of the visual effects and animation used by the UIKit framework and provides an 

Objective-C based programming interface for creation of specialized animation within iPad apps. 

6.4.8 OpenGL ES framework (OpenGLES.framework) 

For many years the industry standard for high performance 2D and 3D graphics drawing has been OpenGL. 

Originally developed by the now defunct Silicon Graphics, Inc (SGI) during the 1990s in the form of GL, the 
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open version of this technology (OpenGL) is now under the care of a non-profit consortium comprising a 

number of major companies including Apple, Inc., Intel, Motorola and ARM Holdings.  

OpenGL for Embedded Systems (ES) is a lightweight version of the full OpenGL specification designed 

specifically for smaller devices such as the iPhone and iPad. 

6.4.9 GLKit Framework (GLKit.framework) 

The GLKit framework is an Objective-C based API designed to ease the task of creating OpenGL ES based 

applications.  

6.4.10 NewsstandKit Framework (NewsstandKit.framework) 

The Newsstand application is a feature of iOS and is intended as a central location for users to gain access to 

newspapers and magazines. The NewsstandKit framework allows for the development of applications that 

utilize this new service. 

6.4.11 iOS Audio Support 

iOS is capable of supporting audio in AAC, Apple Lossless (ALAC), A-law, IMA/ADPCM, Linear PCM, µ-law, 

DVI/Intel IMA ADPCM, Microsoft GSM 6.10 and AES3-2003 formats through the support provided by the 

following frameworks. 

6.4.12 AV Foundation framework (AVFoundation.framework) 

An Objective-C based framework designed to allow the playback, recording and management of audio 

content. 

6.4.13 Core Audio Frameworks (CoreAudio.framework, AudioToolbox.framework and 

AudioUnit.framework) 

The frameworks that comprise Core Audio for iOS define supported audio types, playback and recording of 

audio files and streams and also provide access to the device’s built-in audio processing units. 

6.4.14 Open Audio Library (OpenAL) 

OpenAL is a cross platform technology used to provide high-quality, 3D audio effects (also referred to as 

positional audio). Positional audio may be used in a variety of applications though is typically used to provide 

sound effects in games. 

6.4.15 Media Player Framework (MediaPlayer.framework) 

The iOS Media Player framework is able to play video in .mov, .mp4, .m4v, and .3gp formats at a variety of 

compression standards, resolutions and frame rates. 

6.4.16 Core Midi Framework (CoreMIDI.framework) 

Introduced in iOS 4, the Core MIDI framework provides an API for applications to interact with MIDI 

compliant devices such as synthesizers and keyboards via the iPad’s dock connector. 
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6.5 The iOS Core Services Layer 

The iOS Core Services layer provides much of the foundation on which the previously referenced layers are 

built and consists of the following frameworks. 

6.5.1 Address Book Framework (AddressBook.framework) 

The Address Book framework provides programmatic access to the iPad Address Book contact database 

allowing applications to retrieve and modify contact entries. 

6.5.2 CFNetwork Framework (CFNetwork.framework) 

The CFNetwork framework provides a C-based interface to the TCP/IP networking protocol stack and low 

level access to BSD sockets. This enables application code to be written that works with HTTP, FTP and 

Domain Name servers and to establish secure and encrypted connections using Secure Sockets Layer (SSL) or 

Transport Layer Security (TLS). 

6.5.3  Core Data Framework (CoreData.framework) 

This framework is provided to ease the creation of data modeling and storage in Model-View-Controller 

(MVC) based applications. Use of the Core Data framework significantly reduces the amount of code that 

needs to be written to perform common tasks when working with structured data within an application.  

6.5.4 Core Foundation Framework (CoreFoundation.framework) 

The Core Foundation framework is a C-based Framework which provides basic functionality such as data 

types, string manipulation, raw block data management, URL manipulation, threads and run loops, date and 

times, basic XML manipulation and port and socket communication. Additional XML capabilities beyond 

those included with this framework are provided via the libXML2 library. Though this is a C-based interface, 

most of the capabilities of the Core Foundation framework are also available with Objective-C wrappers via 

the Foundation Framework. 

6.5.5 Core Media Framework (CoreMedia.framework) 

The Core Media framework is the lower level foundation upon which the AV Foundation layer is built. Whilst 

most audio and video tasks can, and indeed should, be performed using the higher level AV Foundation 

framework, access is also provided for situations where lower level control is required by the iOS application 

developer. 

6.5.6 Core Telephony Framework (CoreTelephony.framework) 

The iOS Core Telephony framework is provided to allow applications to interrogate the device for information 

about the current cell phone service provider and to receive notification of telephony related events. 

6.5.7 EventKit Framework (EventKit.framework) 

An API designed to provide applications with access to the calendar, reminders and alarms on the device. 
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6.5.8 Foundation Framework (Foundation.framework) 

The Foundation framework is the standard Objective-C framework that will be familiar to those who have 

programmed in Objective-C on other platforms (most likely Mac OS X). Essentially, this consists of Objective-C 

wrappers around much of the C-based Core Foundation Framework. 

6.5.9 Core Location Framework (CoreLocation.framework) 

The Core Location framework allows you to obtain the current geographical location of the device (latitude, 

longitude and altitude) and compass readings from with your own applications. The method used by the 

device to provide coordinates will depend on the data available at the time the information is requested and 

the hardware support provided by the particular iPad model on which the app is running. 

6.5.10 Mobile Core Services Framework (MobileCoreServices.framework) 

The iOS Mobile Core Services framework provides the foundation for Apple’s Uniform Type Identifiers (UTI) 

mechanism, a system for specifying and identifying data types. A vast range of predefined identifiers have 

been defined by Apple including such diverse data types as text, RTF, HTML, JavaScript, PowerPoint .ppt files, 

PhotoShop images and MP3 files.  

6.5.11 Store Kit Framework (StoreKit.framework) 

The purpose of the Store Kit framework is to facilitate commerce transactions between your application and 

the Apple App Store. Prior to version 3.0 of iOS, it was only possible to charge a customer for an app at the 

point that they purchased it from the App Store. iOS 3.0 introduced the concept of the “in app purchase” 

whereby the user can be given the option to make additional payments from within the application. This 

might, for example, involve implementing a subscription model for an application, purchasing additional 

functionality or even buying a faster car for you to drive in a racing game. With the introduction of iOS 6, 

content associated with an in-app purchase can now be hosted on, and downloaded from, Apple’s servers. 

6.5.12 SQLite library 

Allows for a lightweight, SQL based database to be created and manipulated from within your iPad 

application. 

6.5.13 System Configuration Framework (SystemConfiguration.framework) 

The System Configuration framework allows applications to access the network configuration settings of the 

device to establish information about the “reachability” of the device (for example whether Wi-Fi or cell 

connectivity is active and whether and how traffic can be routed to a server). 

6.5.14 Quick Look Framework (QuickLook.framework) 

The Quick Look framework provides a useful mechanism for displaying previews of the contents of file types 

loaded onto the device (typically via an internet or network connection) for which the application does not 

already provide support. File format types supported by this framework include iWork, Microsoft Office 

document, Rich Text Format, Adobe PDF, Image files, public.text files and comma separated (CSV). 
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6.6 The iOS Core OS Layer 

The Core OS Layer occupies the bottom position of the iOS stack and, as such, sits directly on top of the 

device hardware. The layer provides a variety of services including low level networking, access to external 

accessories and the usual fundamental operating system services such as memory management, file system 

handling and threads. 

6.6.1 Accelerate Framework (Accelerate.framework) 

The Accelerate Framework provides a hardware optimized C-based API for performing complex and large 

number math, vector, digital signal processing (DSP) and image processing tasks and calculations. 

6.6.2 External Accessory Framework (ExternalAccessory.framework) 

Provides the ability to interrogate and communicate with external accessories connected physically to the 

iPad via the dock connector or wirelessly via Bluetooth. 

6.6.3 Security Framework (Security.framework) 

The iOS Security framework provides all the security interfaces you would expect to find on a device that can 

connect to external networks including certificates, public and private keys, trust policies, keychains, 

encryption, digests and Hash-based Message Authentication Code (HMAC).  

6.6.4 System (LibSystem) 

As we have previously mentioned, iOS is built upon a UNIX-like foundation. The System component of the 

Core OS Layer provides much the same functionality as any other UNIX like operating system. This layer 

includes the operating system kernel (based on the Mach kernel developed by Carnegie Mellon University) 

and device drivers. The kernel is the foundation on which the entire iOS platform is built and provides the low 

level interface to the underlying hardware. Amongst other things, the kernel is responsible for memory 

allocation, process lifecycle management, input/output, inter-process communication, thread management, 

low level networking, file system access and thread management.  

As an app developer your access to the System interfaces is restricted for security and stability reasons. 

Those interfaces that are available to you are contained in a C-based library called LibSystem. As with all 

other layers of the iOS stack, these interfaces should be used only when you are absolutely certain there is no 

way to achieve the same objective using a framework located in a higher iOS layer. 
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7. Testing iOS 6 Apps on the iPad – 

Developer Certificates and Provisioning 

Profiles 

In the chapter entitled Creating a Simple iPad iOS 6 App we used the iOS Simulator bundled with the iOS 6 

SDK to test an example application. Whilst this is fine for most cases, in practice there are a number of areas 

that cannot be comprehensively tested in the simulator. For example, no matter how hard you shake your 

computer (not something we actually recommend) or where in the world you move it to, neither the 

accelerometer nor GPS features will provide real world results within the simulator (though the simulator 

does have the option to perform a basic virtual shake gesture and to simulate location data). If we really want 

to test an iOS application thoroughly in the real world, therefore, we need to install the app onto a physical 

iPad device. 

In order to achieve this a number of steps are required. These include generating and installing a developer 
certificate, creating an App ID and provisioning profile for your application, and registering the devices onto 
which you wish to directly install your apps for testing purposes. In the remainder of this chapter we will 
cover these steps in detail. 

Note that the provisioning of physical devices requires membership in the iOS Developer Program, a topic 
covered in some detail in the chapter entitled Joining the Apple iOS Developer Program. 

7.1 Creating an iOS Development Certificate Signing Request 

Any apps that are to be installed on a physical iPad device must first be signed using an iOS Development 

Certificate. In order to generate a certificate the first step is to generate a Certificate Signing Request (CSR). 

Begin this process by opening the Keychain Access tool on your Mac system. This tool is located in the 

Applications -> Utilities folder. Once launched, the Keychain Access main window will appear as illustrated in 

Figure 7-1: 

Chapter 7 
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Figure 7-1 

Within the Keychain Access utility, perform the following steps: 

1. Select the Keychain Access -> Preferences menu and select Certificates in the resulting dialog. 

 

 

Figure 7-2 

2. Within the Preferences dialog make sure that the Online Certificate Status Protocol (OCPS) and 

Certificate Revocation List (CRL) settings are both set to Off, then close the dialog. 

 

3. Select the Keychain Access -> Certificate Assistant -> Request Certificate from a Certificate Authority… 

menu option and enter your email and name exactly as registered with the iOS Developer Program. 

Leave the CA Email Address field blank and select the Saved to Disk and Let me specify key pair 

information options: 
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Figure 7-3 

4. Clicking the Continue button will prompt for a file and location into which the CSR is to be saved. Either 

accept the default settings, or enter alternative information as desired at which point the Key Pair 

Information screen will appear as illustrated in Figure 7-4: 

 

 

Figure 7-4 

 

5. Verify that the 2048 bits key size and RSA algorithm options are selected before clicking on the Continue 

button. The certificate request will be created in the file previously specified and the Conclusion screen 

displayed. Click Done to dismiss the Certificate Assistant window. 
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